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ABoUuT WEBCT

WebCT Inc. is the world’s leading provider of integrated e-Learning systems for higher
education. With WebCT, institutions can provide more convenient and personalized
learning options for students, expand access to academic programs, and improve course
quality.

WEBCT CAMPUS EDITION

WebCT Campus Edition™ 4.0 (hereafter referred to as WebCT CE) allows course
designers to create an interactive learning environment that brings instructors and
students together in a virtual classroom. This online course management solution
combines course development and delivery tools with a comprehensive course
administration system. With WebCT CE, you can create entire courses online or
complement a classroom-based course.

Use WebCT CE to:

e provide course materials that include text, complex equations, images, video, and
audio

e evaluate students with quizzes and assignments

e communicate with students via discussions, electronic mail, real-time chat
sessions, and an interactive whiteboard

e facilitate learning using a searchable index, glossary, and image database for each
course

e cencourage student interaction by enabling the creation of student homepages and
online presentations

e share course content with other designers and institutions
e record, maintain, and communicate grades
e enable student self-evaluations through self tests and progress tracking

e obtain data that allows you to analyze the effectiveness of your course



ABOUT THE TUTORIAL

AUDIENCE

The Getting Started Tutorial introduces course designers to the WebCT CE course-
building process. A course designer may be an instructor, a teaching assistant, or an
instructional designer-anyone building a course from the designer interface of WebCT
CE.

This tutorial is intended for designers who have never used WebCT CE before. However,
this guide assumes that you possess basic computer skills and that you are familiar with
web browser navigation.

ORGANIZATION

The tutorial is divided into three parts:

Q PART ONE: GETTING STARTED introduces the WebCT CE Campus Edition 4.0
workspace and discusses some key concepts that are central to building a WebCT CE
course. This section should be read before proceeding to Parts Two and Three.

Q PART TWO: CREATING BASIC COURSE ELEMENTS contains three lessons. The
first lesson is directed at creating a central web page for your course. The next two
lessons explain how to add course content. Each lesson is a stand-alone unit.

Q PART THREE: ADDING COMMUNICATION AND EVALUATION TOOLS contains
two lessons directed at adding course elements that allow the exchange of information
between WebCT CE users. A third lesson is directed at adding a course element to
evaluate your students’ progress. Each lesson is a stand-alone unit.

Although the lessons in Parts Two and Three can be completed in any order you choose,
you’ll gain a better understanding of the course building process by progressing through
the tutorial in the order in which it’s presented.

REQUIREMENTS

Before you begin the tutorial, your WebCT CE administrator must create an empty
course, called Introduction to Internet Communication, in which you have designer
access. This tutorial walks you through the process of adding tools and course content to
that empty course.



If you haven’t already done so, contact your WebCT CE administrator and ask that a
blank course be added to your User Record. Request that the administrator follow the
detailed instructions found in the System Administrator’s Guide: WebCT Campus Edition
4.0, in Chapter 3: Course Management, “Creating a Course for the Getting Started
Tutorial.”

TUTORIAL CONVENTIONS

The following conventions are used in this document:

Font characteristic or symbol Description

bold Identifies a button or text that can be clicked. For
example:
Click OK.

italic Identifies a tool name, screen name, or screen element.

This type of formatting is also used to reference another
document or another section of this document. For
example:

On the Welcome screen, click Next.
courier Identifies text that the user enters, or has entered, into a

field or text box. This font is also used for URLs, e-
mail addresses and filenames. For example:

In the text box, enter: Syllabus
http://www.webct.com

USING THIS TUTORIAL

You’ll be logged in to WebCT CE while you work through the lessons contained in this
tutorial. For ease of reference, you may want to print this document. The tutorial is 94
pages in length.

If you prefer to view the tutorial electronically using Adobe® Acrobat™ Reader”, there are
embedded links for your convenience. Use the links to access referenced web pages or
other sections of this document. To return to the previous page, use Go to previous view

@ displayed in the Reader toolbar.



PART ONE: GETTING STARTED



LESSON 1: LOGGING IN AND

EXPLORING THE WEBCT CE
ENVIRONMENT

Before you start creating your course, it’s best to become familiar with some WebCT
terminology and the WebCT CE workspace.

There are a number of screen features that are common to all areas of WebCT CE. To
navigate quickly and efficiently through your course, it’s helpful to understand the layout
and function of these workspace features.

LEARNING OBJECTIVES

After completing this lesson, you’ll be able to:
e explain the course building concepts that are central to WebCT
e Jloginto WebCT CE and access a course.
¢ identify the four main areas of the WebCT CE workspace.
e access online Help to get more information on using WebCT CE.
e preview WebCT CE screens to see how they appear to students.
e cxplain the roles of the Course Menu and the Homepage.
e access the Control Panel and describe the course modification options it contains.

e navigate through your course using the Course Menu and the breadcrumbs.

UNDERSTANDING WEBCT’S KEY COURSE
BUILDING CONCEPTS

To better understand the WebCT CE course building process, you need to become
familiar with two key concepts: links and tools.

LINKS

Your institution’s WebCT CE software is stored on a web server along with all the files
for each WebCT CE course. Data such as course content and student information are not
stored on your computer. You and your students access the WebCT server and the course
files via a web browser, such as Microsoft® Internet Explorer or Netscape Navigator”.



You access a specific area of your course on the server, such as Mail or Glossary, by
clicking a link. This sends a web page request to the server. The server responds by
delivering the corresponding web page to your computer for display.

Because all files reside on the WebCT server, if you want to add existing course material
to your WebCT CE course, you must upload the files from your computer to the server.
In the process of uploading the file, you also create a link to that file. You and your
students access the file by clicking the link.

The diagram below illustrates how all communication within the WebCT environment
passes through the WebCT server.

Uploaded course
files are stored
on server

WebCT Server
A
Student clicks —— D?sign?r —
link to request clicks link to
course file request ;
Server sends course file Server sends file
file for display for display
Designer
—— uploads files
to server
Student computer Designer computer




TooLs

You build your course in WebCT CE using tools. Each course element has its own tool.
For example, to create the course element, Mail, you use the Mail tool.

Before you can use a tool, you must add it to your course. For example, to create a course
glossary, you first add the Glossary tool. This places a Glossary link on the Course Menu
and the course Homepage. By clicking the link, you can then add content to your
glossary. You and your students access the completed glossary by clicking the same
Glossary link. This concept will become clearer as you work through this tutorial and add
tools to your course.

GETTING STARTED ACTIVITIES

There are two activities in this lesson:
e logging in to WebCT CE and accessing your course

e cxploring the WebCT CE work environment and becoming familiar with its
features

LOGGING IN

All administrators, students, teaching assistants, and designers need an ID and password
to log in to the WebCT server and access courses. You also need an ID and password to
complete the lessons in this tutorial.

Your WebCT CE administrator is responsible for providing you with a URL (server
address), a WebCT ID, and a password. If you don’t have this information yet, contact
your administrator.

1. Open your web browser.

2. Enter the URL provided by your WebCT CE administrator. The URL looks
something like this:

http://webct.institution.edu
The WebCT Entry Page appears.
Click Log in to myWebCT. The Login to WebCT screen appears.
4. Enter the WebCT ID and Password provided by your WebCT CE administrator.
5. Click Log in. The myWebCT screen appears.
Tip:  myWebCT provides you with centralized access to all of your WebCT CE
courses. Depending on administrator settings, myWebCT can also contain
links to Announcements from your school, bookmarked URLs, and a Global

Calendar. For more information on using myWebCT, click Help on the
myWebCT screen.



6. Under Courses, click Introduction to Internet Communications. This is the tutorial
course that your WebCT CE administrator set up for you. The Course Design Center
screen appears.

7. Read the description provided onscreen about this feature. Although it’s
recommended that new designers use the Course Design Center to build a course, for
the purposes of this lesson, click Use the Course Design Center later. (You’ll use
the Course Design Center to perform a task in an upcoming lesson.) A confirmation
message appears.

8. Click OK. The course Homepage appears.

You’re now logged in to WebCT CE and are in the tutorial course. The screen displayed
is the Homepage.

Homepage

You can think of the Homepage as your course’s home base. It is the central place where
you can place links to all your course elements. Links can appear as text only, an icon, or
both text and an icon. You select the format that you prefer. As you progress through the
tutorial, you’ll customize your Homepage’s appearance and add links to seven different
course elements to it.

You can also create specialized pages called Organizer Pages. You can use an organizer
page to group course elements that are similar and display their links. For example, you
can create an Organizer Page called Communications that contains links to a discussions
area, a chat area, a mail area, and a calendar.

For more information on creating Organizer Pages, see the Course Design Center or the
online Help topic, Organizer Pages. To access the online Help, click Help on the Menu
Bar.

LEARNING ABOUT THE WEBCT CE WORKSPACE
There are four features that are common to every screen in WebCT CE. They are:
e Menu Bar
e Course Menu
e Control Panel
e Content area consisting of the main frame and the Actions frame

These features are identified in the screen example on the following page.



er Log Qut Help

I Introduction to Internet Communications
Control - Control Panel

Wiew Designer Options
Panel I N
¥ Course Menu

Homepage

Homepage i Actions
To add text to this area of your page, click Add upper textblock. % indicates a selection is required
from the main frame.
I} Use Homepage Wizard
Options: Links
| &dd page or tool
‘four page does not cantain any links to pages or toals. To add links, click Add [ Edi
page or tool. . _E_d_IF_ i
(% Delete

| Reveal
Course |
Menu

[ Specwfy selective release

To add text to this area of your page, click Add lower textblock.

('-H- Mave backward

|3 Mave forward

|f% Move to organizer page

I Actions
frame

|3 mave to Course Menu

[ éﬁpy to Course Menu

Options: Textblocks

[add .upp.er textblock

[Add lower texthlack
‘ | Edit]

L ‘ [ Delete
main frame

[f% Mave up

|3 Move down|

Content area
Now, take a closer look at each of these screen elements.
Menu Bar

The Menu Bar contains links to myWebCT, Resume Course, Course Map, Check
Browser, Logout, and Help.

rse Map  Check Bro r  Log Qut

Help
tabs Introduction to ‘Internet Communications
| Introduction to
I Yiem j Designer Options

Homepage

breadcrumbs

The breadcrumbs show your current location in the course and the tabs indicate whether
you’re in View or Designer Options.



These Menu Bar items are described below.

Option Description

myWebCT Returns you to the myWebCT screen.

Resume Course Allows students to resume their place in the Content Module (course
content).

Course Map Allows you and your students to view the structure of the entire

course on one page. The course elements are links, which enable you
to go to any place in the course from a single page. This feature
simplifies navigation and is especially useful for courses with a large
number of course elements.

Check Browser Allows you and your students to determine if your browser is
compatible with WebCT CE.

Log Out Logs you out of the current WebCT CE session and returns you to
the WebCT Entry Page.

Help Links you to context-sensitive online help.

View Allows you to see how the course appears to students. On some

screens, View only approximates what a student sees.

Designer Options Allows you to make modifications to course elements, pages, and
content.
Breadcrumbs Shows your location in the course and provides links to previous

screens. You can use this feature to return to the Homepage from
almost anywhere in your course.

Now, access one of the options on the Menu Bar.

10



To access the online Help
1. From the Menu Bar, click Help.

BCT Resurne Course Course Map  Check Browser

Introduction to Internet Communications Help

Cnn'tr.t.il..Pa.nellll
I WView \l Designer Options \

W Course Menu Homepage

The online Help topic, Homepage — About appears in a new browser window.

2. From the Help menu bar, click Help Index. The Designer Help Index appears. Links
to information and instructions on using WebCT CE appear.

3. Close the browser window to return to the Homepage.

Next, see how the Homepage appears in View.

To switch between the View tab and the Designer Options tab

As a designer, you’ll spend most of your time in Designer Options where you can add to
and change your WebCT CE course using options in the Actions frame. Use the View tab
when you want to see how a screen appears to your students.

1. Click the View tab.

myWwebCT Resume Course Course Map ©Check Browser Log ©ut  Help

Introduction to Internet Communications
I Wi Designer Options \

_Control Panel

W Course Menu Ho age

|
Click View

Notice how the Actions frame is removed from the Homepage. The Actions frame is
only for designer use.

2. To return to designer view, click the Designer Options tab.

Course Menu

Like the Homepage, you can place links to all your course elements on the Course Menu.
It is visible to designers and students. Since you haven’t started building a course yet, the
Course Menu only contains Homepage. The green arrow (¥) allows you to toggle
between displaying and hiding the Course Menu to change the size of the Content area.
Using this option only affects your view of the Course Menu. Other users are not
affected.

If you want to change the display of the Course Menu for all users, see the online Help
topic, Course Settings — Course Menu. To access the online Help, click Help on the Menu
Bar.

11



The Homepage and the Course Menu both display links to other elements in your course.
The Homepage can display icon and text links and is readily accessed from the
breadcrumbs at all times. The Course Menu displays text links only, is accessible from
most areas of your course, and affects the size of the Content area. As your online course
goals become clearer, you may decide that the use of only one of these WebCT CE
features is sufficient.

Later, you’ll add links to both the Course Menu and the Homepage to gain an
understanding of both methods of displaying links.

To change the display of the Course Menu

1. Click ¥. The Course Menu is hidden in a drop-down box Pl- course Menu - =] and the
Content area enlarges.

2. Click k. The Course Menu appears.

Control Panel

The Control Panel is the central location for all designer utilities and course management
options. It is visible only to designers. In Control Panel, designers can access the
following course design utilities: Add Page or Tool, Edit Page or Tool, Manage Files,
Manage Course and Course Settings.

From the Control Panel, you can do the following:
e add pages or tools to create course elements
e edit the content of course elements
e update your students’ WebCT CE course content
e add, edit, organize, and download your course files
e manage the records of students and teaching assistants
e track students’ progress
e back up your course

e change your course’s appearance and settings

12



There are two versions of the Control Panel: Basic Control Panel and Expanded Control
Panel. By default, when you click Control Panel, the Basic Control Panel appears.

Basic Control Panel Expanded Control Panel

Add Page or Tuull Edit Page or Tuu|| Manage Files| Manage Euurse| Course Settings|
Add tools to your Customize the Add, download, change, Manage student and Zhange the appearance
course to evaluate, Homepage and change and organize the files in teaching assistant and behavior of your
comrnunicate with, and course content, YOuUr course, records, Track student course,

provide course content progress, Manage

to students. Develap Update the student course backups.

course content for view of the Content

students with Tools Modules in your course.

such as Syllabus and
Content Module, Group
course content and
toaols using Qrganizer
Pages.

Update student view

Create new content for your course using the Course Design Center,
Course Design Center &% ‘

The Basic Control Panel contains links to utilities where you can perform the most

common course creation and course management tasks. The Expanded Control Panel

goes beyond the Basic Control Panel to include links to more advanced tasks.

To access the Control Panel

» Click Control Panel. The Basic Control Panel appears. It is recommended that new
users use the Basic Control Panel.

To access the Expanded Control Panel

» Click Expanded Control Panel.

Homepage = Basic Control Panel

Basic Control Panel Expanded Contral Panel
Add Page or Tuull Edit Page or Tool ‘ Manage Filesl Manage Course Course Settings

Click Expanded Control Panel

The Expanded Control Panel appears.

Tip: Once you gain some experience using WebCT CE, you may prefer to change the
default Control Panel to Expanded Control Panel by clicking Set as default
view.

For now, go back to the Basic Control Panel.

» Click Basic Control Panel. The Basic Control Panel appears.

Haormepage = Expanded Control Panel

Expanded Control Panel | Basic Control Panel Set as default view
Add Page or Tnnl| Edit Page or Tnul| Manage Files| Manage Course Course Settingsl

[
Click Basic Control Panel

13



Under the Basic Control Panel, you’ll notice a link to the Course Design Center.

Course Design Center 1{}\

This gives new designers the option of using either the Control Panel to build their
course or the Course Design Center.

Now, return to your Homepage.
» To return to the Homepage, in the Course Menu or breadcrumbs, click Homepage.

Content Area

When you first access a course element from the Course Menu or Homepage, the content
area is divided into two sections or frames: the main frame and the Actions frame.

The main frame is where you perform your course building tasks and where content is
displayed to you and your students. The main frame is visible to all users.

The Actions frame contains links to the various editing, customizing, and organizing
options available for a particular course element. The Actions frame is visible only to
designers.

A Final Note about WebCT CE Navigation

As you become more familiar with the CE workspace, you’ll discover that there’s more
than one way to achieve a goal. You’ve already learned that you can use either the
breadcrumbs or the Course Menu to return to the Homepage. Similarly, from the
Homepage, you can access Add Page or Tool directly from the Actions frame, or you can
use the Control Panel. You choose the method that works best for you.

This idea of flexibility of use is central to WebCT. As you gain experience in using the
WebCT CE workspace, you’ll discover the numerous ways you can customize WebCT
CE to best suit your preferences and on-line teaching goals.

Warning: . Avoid using your browser’s Back and Forward buttons to navigate
through WebCT CE. Instead, use the Course Menu, Control Panel, Menu
Bar and breadcrumbs as discussed earlier in this lesson.

You’re finished Lesson 1: Logging in and Exploring the WebCT CE Environment. In the
next lesson, you’ll learn how to plan your course.
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LESSON 2: PLANNING YOUR WEBCT

CE COURSE

Becoming familiar with the WebCT CE software is important, but it is only part of the
online course-building picture. To create a truly effective online course, you should plan
your course by applying the same principles you use when designing a traditional
classroom course. The difference is that your course’s purpose, content, and structure will
be dependent on and enhanced by the capabilities of WebCT CE.

This lesson only touches on the key points that you should consider when planning a
WebCT CE course, but we want to stress the importance of planning. If you develop and
implement a methodical course design plan, you can produce an effective course more
efficiently. When you are ready to build the actual course that you’ll use at your
institution, you may find it helpful to seek additional resources to assist you. WebCT
resources can be found at www.webct.com/quickstart and
www.webct.com/ask drc

LEARNING OBJECTIVES

After completing this lesson, you will be able to:

e describe the three key areas that you need to consider when planning an online
course.

e Jlocate additional resources to assist you in planning your WebCT CE course.

UNDERSTANDING ONLINE COURSE BUILDING
BASICS

DEFINING YOUR COURSE GOALS

Your first step in the course planning process is familiar to you. You should determine
the desired learning goals for the course. As in the planning of a traditional classroom
course, you want to establish what a student should know and be able to do as the result
of their experience in your course. For the most part, the goals of an online course are
identical to those of a course taught in a classroom setting. You may discover however,
that the use of WebCT CE provides the opportunity for your students to gain some skills
and experiences that they would not gain in a traditional course. You may want to
consider these when you are developing your course goals.
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USING WEBCT CE TO ACHIEVE YOUR GOALS

Once you have determined your course goals, you determine how you can achieve those
goals using WebCT CE.

If you are using WebCT CE to supplement a classroom course, you should determine
which goals could be achieved with the best results by using a component of WebCT CE.
If you are creating a truly web-based course, you strive to achieve all of your course
goals with WebCT CE. In this case, you determine which tools to use to achieve each
goal.

In both instances, you should have an understanding of all the components of a WebCT
CE course. Appendix A: WebCT Course Tools on page 80 contains a table that provides a
brief description of each WebCT CE tool and how the tool can be used. Use the table to
select the tool or tools you can use to achieve each course goal.

An example of a course goal for a first year English course is provided below. The
WebCT CE tools that might be used to assist in achieving this goal are also provided.

Course Goal WebCT CE Tools
As the result of reading, analyzing, and e Content Module — for reading
discussing the literary works of published literary works

writers, students will be able to subjectively

. - e Discussions — for discussing and
evaluate their own writing.

analyzing literary works

e  Chat — for discussing and analyzing
literary works

o Assignments — for submitting writing
samples and critiques of writing
samples

o  Student Homepages — for presenting

writing samples for others to
evaluate

To create an online course that adds value to each student’s learning experience, it is
essential that you understand how to use WebCT CE to meet your course goals.

ORGANIZING YOUR MATERIALS

Your next step is to decide what course materials to put online and to organize them. In a
web-based course, all materials are online. However, if you’re supplementing a
classroom course, consider your course goals when deciding which course materials to
put online.

It’s a good idea to create a content outline to organize these materials before you upload
them to the WebCT server. You may want to divide them into chronological lessons or
units to correspond with classroom lectures, or group them according to subject matter.
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If you are going to enhance your course
with online communication elements
such as a discussions forum or a chat
area, coordinate the use of these course
elements with each unit of study. For
example, you may want to schedule a
weekly chat session where students can
discuss issues related to the material
covered that week. In addition, if you are
creating quizzes, surveys, self-tests, or
assignments in your WebCT CE course,
organize the content and their schedule
as well.

What file format can | use?

Course content files that use Text (.txt) and
HTML (.html, .htm) file formats are
recommended. These formats can be edited
in WebCT CE and all users can view them
within their web browsers. File formats, such
as . doc (Microsoft® Word document) and
.x1s (Microsoft® Excel spreadsheet) among
others, can also be used in your online
course. However, users must have the
corresponding software, such as Microsoft
Word or Excel, installed on their computers
to view these files.

SAMPLE COURSE DESIGN SCENARIOS

The following scenarios suggest the creation of four possible online courses that
incorporate the content of this tutorial. They vary in purpose and complexity according to
the scenarios outlined. They are provided here to demonstrate the course design
principles described in this lesson and to illustrate how WebCT CE can be used to

enhance any course.

Note: This tutorial is designed to be a flexible learning tool. Although we recommend
that you complete all lessons, and complete them in the order in which they are
presented, Lessons 3 to 8 are stand-alone units. If you find that one of the
scenarios listed below matches your online course goals, feel free to concentrate
on those lessons first. You can return to the tutorial at any time to complete the

remaining lessons.

Scenario Suggested WebCT Tutorial Lesson

CE Tools
You are new to using the Internet to e  Syllabus Lesson 4: Adding a Syllabus
teach. You want to ease yourse}f and o culendar Lesson 7: Creating a Course
your students into online learning, Calendar
and use WebCT to complement your
regular classroom sessions.
You want to create areas for students e  Discussions Lesson 6: Communicating with
to pose questions, discuss ideas, o Chat Your Students

analyze information, and synthesize
concepts.
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Scenario Suggested WebCT Tutorial Lesson

CE Tools
You want to supplement your e Syllabus Lesson 4: Adding a Syllabus
classroom course by providing access o =001 Module Lesson 5: Adding Course

to some course materials online. You
also want to promote individual
learning and provide immediate

e Quizzes/Surveys Content

Lesson 8: Creating a Quiz for

feedback so students can gauge how Your Students

well they are doing.

You want to take full advantage of e  Syllabus Lesson 4: Adding a Syllabus
WebCT CE’s most common tools to o Content Module Lesson 5: Adding Course
enhance the learning experience of Content

your students. You want to create * Discussions

. Lesson 6: Communicating with
areas for the presentation of course e Chat g

. . . Your Students

content, the analysis and discussion of o  cy/endar
; Lesson 7: Creating a Course
course content, and the evaluation of rres/S
. [}
each student’s understanding of that Quizzes/Surveys Calendar
course content. Lesson 8: Creating a Quiz for
Your Students

You’'re finished Lesson 2: Planning your WebCT CE Course. You’re now ready to build
a WebCT CE course.
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PART TWO: CREATING BASIC
COURSE ELEMENTS



LESSON 3: CUSTOMIZING YOUR

HOMEPAGE

The Homepage is the first screen that your students see when they enter your course. It’s
created automatically and can serve as your course’s main Organizer Page providing
links to all other WebCT CE course elements. As a designer, you can add, remove, and
reorganize these links using the various link options available on the Homepage.

You can also customize the appearance of your Homepage. You can add text or graphics
to the page or change the color scheme to better complement your course.

LEARNING OBJECTIVES

After completing this lesson, you’ll be able to:
e explain the role of the Homepage in your course.
e describe the role of the Course Design Center in the course-building process.
e create a heading for your Homepage using the Homepage Wizard.
e add text to your Homepage to customize its appearance.
e change the color scheme of the Homepage to best suit your needs.

o refer to the online Help to get more information about other Homepage options.

HOMEPAGE ACTIVITIES

There are two activities in this lesson:
e adding a heading to your Homepage using the Homepage Wizard

e changing your Homepage colors

ADDING A HEADING TO YOUR HOMEPAGE USING THE
HOMEPAGE WIZARD

In this first activity, you’ll use a course design wizard to add a heading to your
Homepage. The wizards assist new users and provide step-by-step instructions on using

some of the more common course building tools. There are eight wizards in all. They are
stored in the Course Design Center.
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Note: Depending on administrator settings, the Course Design Center, or some of the
wizards, may not be available to you in the course you’ll be teaching at your
institution.

Here’s an example of a wizard screen:

: Delete
;%}\wﬂard: Homepage Hide

| To add a textblock to the top of vour Homepage, click Add upper Reveal
textblock.

| Specify selective release
| To add a textblock to the bothomn of your Homepsge, click Add lower
‘textblock. Maove baclkward

Move forward

fReturn to previous menu

1 Move to organizer page
| Cancel wizard g beg

Move to Course Menu

Add upper textblock Copy to Course Menu
Instruction hox add upper textblock 3, |
add lower textblock 4% —— Wand icon
add Edit
page or tool S

Using the wizards More about the Course Design

When using any of the wizards, read and Center

follow the text in the Instruction box The Course Design Center contains

(see the example above). All areas wizards for the following WebCT CE

relating to the wizard are indicated in tools: Homepage, Organizer Page,

blue, while the rest of the screen is gray | Syllabus, Content Module, Discussions,

and temporarily unavailable. Mail, Calendar, and Chat.

Look for the small wand icon: ™. It Wizards can be accessed from the Course

accompanies each screen element that | Design Center, from Add Page or Tool on

requires an action. In some cases, you the Control Panel, or from the actual tool

initiate actions from the wizard once it’s added to your course. You can

instruction box by clicking text. In other | use any of the wizards from start to finish,
cases, you use the actual screen element. | OF you can save your work in a wizard and
Either way, the wizard tells you what to | return to it later.

do next.

Now, use a wizard to add a heading to the Homepage to help identify your course.

To create a Homepage heading
1. Do one of the following:
e If you’re already logged in to the tutorial course, go to step 4.

e Ifyou haven’t logged in to the tutorial course, log in. If you need detailed
instructions, see Logging In on page 7. The myWebCT screen appears.
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Click the tutorial course that was created for you by your WebCT CE administrator,
Introduction to Internet Communications. The Course Design Center or
Homepage appears.

Do one of the following:

o Ifthe Course Design Center appears:
a. Click Use Course Design Center later. A warning message appears.
b. Click OK. The Homepage appears.

o If the Homepage appears, go to step 4.

From the Homepage, in the Actions frame, click Use Homepage Wizard. The
Wizard: Homepage instruction box appears.

In the instruction box, under Select an option, click Manage textblocks. Textblocks
are areas of text and/or graphics that you can add to the main frame of some screens.

Again, under Select an option, click Add upper/lower textblock.

Click Add upper texthlock 3%

Read the text in the Wizard: Homepage Instruction box. You’ll add a Text Heading.

Under Text Heading, next to Text, enter: Introduction to Internet
Communications.

10. Next to Alignment, select Center.

11.
12.
13.

14.

To make the heading stand out, next to Style, select Bold.

Select a text color. From the Color drop-down list, select Navy.

Choose a font size. From the Size drop-down list, select 6.

Note: The HTML font sizes used here are relative sizes unlike the specific point

sizes used by most word-processors. HTML font sizes gets progressively
larger as you move from size 1 to size 7.

. I3
Scroll to the bottom of the screen and click M. The Wizard: Homepage
instruction box appears.
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15. Click Save and exit wizard.

| &% Wizard: Homepage

|fou can customize the appearance and layout of tool links on your
| Homepage.

| Select an option:

# Manage textblocks
add and edit text that appears either above the tool links
{upper textblock) ar belaw them (lower textblock),

# Select background and banner image
Chaoose an irnage that appears at the top or on the background
of your Homepage .

* Modify layout
Modify placement of the tool links on your Homepage.

¢ Customize page colors
Choose a color set for the text, links, and background on your
Hormepage .

| cancel wizard
| Save and exit wizard

[,

Click Save and exit wizard

The Homepage appears and your new heading is displayed.
You’ve seen how your heading looks in Designer Options view. Now, see how the
heading appears to your students.
To preview your Homepage

» From the Menu Bar, click the View tab. The student view of the Homepage appears.

CHANGING YOUR HOMEPAGE COLORS

Currently, your Homepage displays the Course Default color set designated by your
WebCT CE administrator. You can change the color scheme of your Homepage to a
different pre-defined color set, or your can create your own custom color scheme.

In this lesson, you’ll create a custom color set by customizing the following on the
Homepage:

e text color
e link color

e background color

To create a custom color scheme
1. From the Homepage, click the Designer Options tab if it isn’t already selected.

2. Inthe Actions frame, scroll down to the Customize section and click Customize page
colors. The Customize Page Colors screen appears. In the table, page colors that are
currently assigned to each Color Set are displayed under Color Preview.
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10.
11.

Customize Page Colors

Current set: Mone
Default course colar set: Color set for page: Course default

Color Set Color Preview

i get A Text, Link, Wisited Link

" get B Text, Link, Yisited Link

" getC Text, Link, Yisited Link

" getD Text, Link, Wisited Link

" SetE Text, Link, \isited Link [ Background
color

" High contrast Text, Link, Visited Link

" Custom Text, Link, Wisited Link

Custom color

Set text -:u:ul-:ur'| Set link color .
set section

Set visited link u:u:ulu:ur| Set background color

Llpu:late| Canu:e|| Course -:Iefault|

From the table, under Color Set, select Custom. Currently, the Text color is black;
keep that color.

Under Custom, click Set link color.

From the color grid, select any shade of blue that you like. The color is shown in the
Preview frame.

Click Update. The Customize Page Colors screen appears and the Link color is
updated.

Under Custom, click Set background color.

From the color grid, select any shade of pale yellow that you like. The color is shown
in the Preview frame.

Click Update. The Customize Page Colors screen appears and the Custom
background color is updated.

Verify that the Custom color set is still selected.

Click Update. The Homepage appears displaying the new color scheme. You won’t
be able to see the new link color until you add some tools to the Homepage. You’ll
add more tools in the next few lessons. Remember to look for the link color at that
time.

Now, see how the new color set appears to your students.

To preview your Homepage

>

From the Menu Bar, click the View tab. The student view of the Homepage appears.
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You’re finished the activities in this lesson. Go to the next section, Related Activities, or
the next lesson.

RELATED ACTIVITIES

If you’re interested in customizing your Homepage further, you may want to spend some
time working through some of the following activities.

Note: To access the Help Index, click Help on the Menu Bar and then near the top of the
screen, click Help Index.

To... Go to...

e add lower textblocks e the online Help topic: Homepage -

e edit, delete, or organize textblocks Modifying Textblocks.

e add images to the Homepage e the online Help topic: Homepage -

e change the background color Modifying Format.

e add a banner to the top of the page

e use the Homepage wizard to: manage o the Homepage Wizard in the Actions
textblocks, select background and banner frame. More information about the
images, modify layout, or customize page wizards can be found in the online Help
colors topic: Course Design Center.

You’re finished Lesson 3: Customizing your Homepage. In the next lesson, you’ll learn
how to add your course syllabus to a WebCT CE course.
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LESSON 4: ADDING A SYLLABUS

A syllabus is a course’s instructional road map designed to assist both the instructor and

the student. It’s a summary outline of the course’s planned lessons, activities, resources,

and student requirements. With WebCT CE’s Syllabus, you can upload a course syllabus
that’s already prepared, or create a customized syllabus using the Syllabus tool.

LEARNING OBJECTIVES

After completing this lesson, you’ll be able to:
e create a link to Syllabus on your Course Menu and Homepage.
e upload a zip file of course content and unzip it.
e add a course syllabus to your course.
¢ modify a syllabus by adding or removing content.
e use the HTML editor to edit files.

e refer to the online Help to get more information about other Syl/labus options.

SYLLABUS ACTIVITIES

There are four activities in this lesson:
e adding Syllabus to your course
e uploading the sample tutorial files
e adding a course syllabus

e cditing a syllabus

ADDING SYLLABUS
First, add Syllabus to your course.
1. Do one of the following:
e If you’re already logged in to the tutorial course, go to step 4.

e Ifyou haven’t logged in to the tutorial course, log in. If you need detailed
instructions, see Logging In on page 7. The myWebCT screen appears.

2. Click Introduction to Internet Communications. This is the tutorial course that was
created by your WebCT CE administrator. The Course Design Center or the
Homepage appears.
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3. Do one of the following:
o Ifthe Course Design Center appears:
a. Click Use Course Design Center later. A warning message appears.
b. Click OK. The Homepage appears.
o If the Homepage appears, go to step 4.

4. From your Homepage, under Options: Links, click Add Page or Tool. The Add Page
or Tool screen appears.

Tip: You can also access Add Page or Tool from the Control Panel.

5. Ifthe Use a wizard when available check box is selected, clear it. You won’t use a
wizard to add the Syllabus tool for this lesson.

6. Under Course Content Tools, click Syllabus. The Add Syllabus screen appears.
7. Inthe Enter a title for this item text box, enter: Syllabus
8. Select where to add links to Syllabus:

a. Select On the Course Menu.

b. Select On an Organizer Page: Homepage.

Notice that Link shows item title, Link shows icon, and Use default icons are selected
by default. Leave these items selected so that the link on the Homepage displays the
title and a default icon.

9. Click Add. The Homepage appears. Notice that there are now links to Syllabus on
both the Homepage and the Course Menu.

If you’ve already completed Lesson 3. Customizing your Homepage, look for the link
color you selected.

Next, add the sample tutorial files to your course so they can be used in upcoming
activities.

ADDING THE SAMPLE TUTORIAL FILES TO YOUR COURSE

Note: If you’ve already added the sample tutorial files to your course, go to Adding a
Course Syllabus on page 31.

Four sample course content files for use with this tutorial are contained in a zip
(compressed) file that you can download from the WebCT website. To add these files to
your course, you need to do the following three tasks:

1. Download the zip file to your computer. Details appear below.

2. Upload the zip file from your computer to the WebCT server. Details appear
below.

3. Unzip the zip file to add the sample tutorial files to the file storage area. Details
appear below.
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To download the sample tutorial files

1. From within your WebCT course, make the necessary selections from your web
browser’s toolbar to open a second browser window.

2. In the second browser window, navigate to http://www.webct.com/customer

From the web page that is displayed, click WebCT Documentation.

4. Under Getting Started Tutorial, click WebCT Campus Edition 4.0 Tutorial Files. A
dialog box appears asking if you want to save or open the file.

5. Save the file to your local hard drive.

6. Once the download is complete, close the dialog box and the second browser
window.

Note: Don’t unzip the file.

7. Go to the next procedure.

To upload the sample tutorial files

Course content files are uploaded to the WebCT server using Manage Files. Manage
Files is the central file storage area and file management utility for your WebCT CE
course. You can access Manage Files from the Control Panel.

The files in Manage Files are organized into two folders:

e My-Files - Your course folder in which you can store, create, and edit files for
your course. All uploaded files are stored here.

e WebCT-Files - A folder that contains the default files that are packaged with

WebCT CE.
In this activity, you’ll use Manage More about file formats
Files to upload the zip file from your Course content files that use Text (.txt) and HTML
computer to the WebCT server. The (-html, .htm) file formats are recommended. These

four files contained in the zip file are formats can be edited in WebCT CE and all users

all HTML files. HTML is a file format | €an view them within their web browsers. File
that can be read by any web browser. formats, such as . doc (Word document) and . x1s
(Excel spreadsheet) among others, can also be used

Now, upload the zip file to the in your online course. However, users must have the

WebCT server. corresponding software, such as Microsoft Word or
Excel, installed on their computers to view these
files.

1. Click Control Panel. The Basic Control Panel appears.
2. From the Control Panel, click Manage Files. The Folders and Files screen appears.

3. Inthe Actions frame, under Options: Files, click Upload. The Upload File screen
appears

4. Next to the Filename text box, click Browse. Your computer’s file browser appears.
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5. Select the zip file you downloaded from the WebCT website and open it. The Upload
File screen appears and the zip file appears in the Filename text box.

Hormepage = Basic Control Panel = Manage Files = Upload File

Upload File

Mote: Depending on the file size and network connection, this process may take several minutes,

Filenarne: lmple_tutnrial_ﬁles.zip Bru:uwse...l
Destination folder: IMg-FiIes vI

Upload | | Cancel

— Click Upload

6. Click Upload. The zip file is added to the Folders and Files list in the My-Files
folder.

Homepage = Basic Control Panel = Manage Files

Folders and Files
Click on a folder below to view its files,

Cisplay this file information: W Size W Date W Time |Update

Hame Size (bytes) Date Time
[T S My-Files
— g] EBlsample_ tutarial_files.zip 3987 April 7, 2003 Z:57pm

[T []¥ebCT-Files

7. Go to the next procedure.

Unzipping the sample tutorial files

Manage Files contains built-in Zip and Unzip options. Now, unzip the zip file to add the
four sample tutorial files to the My—-F1iles folder.

1. From the Folders and Files list, select the zip file.
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2. In the Actions frame, under Options: Files, click Unzip.

Log Qut  Help

Introduction to Internet Communications

[control Panel i
E Wiew ‘{ Designer Options

¥ Course Menu Homepage = Basic Control Panel = Manage Files

Hormepage Folders and Files Actions . )
Syllabus Click on a folder below ta view its files. % indicates a selection is required

from the rain frame.
Display this file information: [ Size W Date W Time Update T indicates multiple selections are
MName Size {bytes) Date Time

allowed.
Options: Files
[~ 4 My-Files oz T
| Create file
| Edit]
[+ Delete
[ copy
[ move
[T Rename
[P+ zip
T+ Unzip| i I
W Click Unzip

[Upload

Zip file is

selected I g] Bisarmple_ tutorial_files zip 3957 April 7, 2003 2:57pm

I~ C1WebCT-Files

The Unzip File screen appears.

3. Click Unzip. The Folders and Files screen appears and the following four files are
added to the My—-Files folder:

e tutorial discussion.html

e tutorial email.html

e tutorial introduction .html
e tutorial syllabus.html

4. The contents of the zip file are extracted. You can delete the zip file. From the
Folders and Files list, select the zip file.

Homepage = Basic Control Panel = Manage Files

Folders and Files
Click on a folder below to view its files,

Display this file information: W Size W Date W Time Update

Mame Size (bytes) Date Time
[T S3My-Files
I gl Eidiscussion.htrml 1665 February 12, 2003 5:57pm
r 3] Eiemail html 1621 March 31, 2003 12:52pm
r g] Eintroduction.htrml 1978 February 12, 2003 6:01pm
W Q) Blsample_ tutorial_files.zip 3987 April 7, 2003 2:57pm
I~ gl Eitutorial_svllabus html 4763 February 21, 2003 12:54pm
[T [1wWebCT-Files

Zip file is selected
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5. Inthe Actions frame, under Options: Files, click Delete. The Delete Files screen
appears.

6. Under Confirm Delete Files, click Delete. The Folders and Files screen appears and
the zip file is deleted.

The remaining files are added to the file storage area in Manage Files. To make these
course content files accessible to your students, you have to add them to one of the course
content areas of your course, such as Syllabus.

Next, add the tutorial syllabus.html file to Syllabus.

Note: The remaining three files are added to Content Module in Lesson 5: Adding
Course Content.

ADDING A COURSE SYLLABUS

1. From the Course Menu, click Syllabus. The Syllabus screen appears.

2. Inthe Actions frame, under Syllabus Source, select Syllabus file. The Syllabus screen
updates to display the Syllabus file screen:

Homepage = Syllabus

syllabus Actions

To use a syllabus saved in a text or HTML file, enter a filename, and then click

. ) I3 i
Update. To preview the Syllabus, select Wisw, X ll=e SyllabisiWi2ard

Current file: Mone Syllabus Source

. To use a syllabus saved in a text or

Filename: | [Browse...| T e S s
option. Information that you have

Update created using the Syllabus toal is

saved but is not displayed.
. Syllabus tool

% syllabus file

3. Under Syllabus, next to the Filename text box, click Browse. The File Browser
appears. The File Browser allows you to select files contained in Manage Files or
upload files from your computer.

Note: In the previous activity, you didn’t use the File Browser to upload the zip file
because the Unzip option isn’t accessible from the File Browser.

4. Under My-Files, select the tutorial syllabus.html file.

Tip: To preview the file, click Q.

5. At the bottom of the screen, click Add selected. The Syllabus screen appears, and
the filename of the uploaded file is displayed in the Filename text box.
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6. Click Update. The filename appears next to Current file.

Homepage = Syllabus

Syllabus Actions
To use a syllabus saved in a text or HTML file, enter a filenarne, and then click = i
Update. To preview the Syllabus, select Wiew, Slise Syllabus Wisand
——Current file: tutarial_svllabus.ktral Syllabus Source
. To use a syllabus saved in a text or
Filename: I m HTML file, select the Syllabus file
option, Information that you have
Update created using the Syllabus tool is

saved but is not displayed.
| Uploaded file is now the current

” =yllabus toal
file being used in Syllabus

& Syllabus file

See how the file is displayed to your students.

To preview your syllabus
» To preview the syllabus, click the View tab.

Next, edit the file you just uploaded and add some new content.

EDITING A SYLLABUS FILE

You can edit any file within WebCT CE if the file format is .t xt, .htm, or .html.
Other file formats must be edited on your computer using the appropriate software and
then uploaded again to your course. For example, if you want to edit a syllabus created in
Microsoft Word, edit it first on your computer using MS Word and then upload it to the

WebCT server using either Manage Files or the File Browser in Syllabus. The edited file
automatically replaces the original syllabus file.

In this lesson, you’ll use Manage Files to edit the tutorial syllabus.html file.

To edit the file
1. Click Control Panel. The Basic Control Panel appears.

2. Click Manage Files. The Folders and Files screen appears displaying the two
folders, My-Files and WebCT-Files, and the files you uploaded.
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3. Under My-Files, select the tutorial syllabus.html file.

Homepage > Basic Contral Panel = Manage Files

Folders and Files
Click on a folder below to view its files,

Display this file information: [ Size | Date | Time |Update

MName Size (bytes) Date Time
[T S My-Files
- gl Eydiscussion.htrnl 1653 April 7, 2003 4:48pm
I~ @] BEemail.html 1609 April 7, 2003 4:48pm
r gl Elintroduction. html 1966 April 7, 2003 4:d&pm
Selected file ——w gl Etutarial_syllabus bt 4752 April 7, 2003 4:48pm

[T [QWebCT-Files

4. Under Options: Files, click Edit. The Edit File screen appears and the file is
displayed in the File content box. Note the HTML tags incorporated into the text.

5. Click HTML editor. The Edit File screen updates and a word-processor-like editor
appears. This tool allows you to edit text and apply formatting to your HTML
document without entering any HTML tags.

Note: For additional information on using the HTML editor, click ? on the toolbar.

6. Using the HTML editor’s scroll bar, scroll down to Lesson 2 under Course Outline
and Reading Assignments.

7. Add the following reading assignment: Read Chapter 1 of Technical
Communication and the Internet.

8. Select the text, Technical Communication and the Internet.

9. Indicate that this is the name of a publication, by applying the italics font style. From
the HTML editor’s toolbar, select Z.
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The text is now in italics.

10. Scroll to the bottom of the screen and click Update. The Folders and Files screen
appears and the file is updated.

Next, see how the revised syllabus appears to your students.

To preview the new Syllabus
1. From the Course Menu, click Syllabus. The Syllabus screen appears.
2. To preview the syllabus, click the View tab.

You’'re finished the activities in this lesson. Go to the next section, Related Activities, or
the next lesson.
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RELATED ACTIVITIES

If you’re interesting in exploring Syllabus further, you may want to spend some time
working through some of the following activities.

Note: To access the Help Index, click Help on the Menu Bar and then near the top of the
screen, click Help Index.

To... Go to...

e create a new syllabus using the Syllabus e the online Help topic: Syllabus.
tool, including:
adding a section

o editing a section
o hiding a section of the syllabus
o reorganizing the syllabus

sections
o deleting all sections in a
syllabus

e switch between an uploaded syllabus file
and a syllabus created using the Syllabus
tool

You’'re finished Lesson 4: Adding a Syllabus. In the next lesson, you’ll learn how to use
WebCT CE to make course materials available to your students.
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LESSON 5: ADDING COURSE

CONTENT

A Content Module is an area where you can place course material such as lecture notes or
reading material. If desired, you can create multiple content modules to organize your
course material according to the structure of your course. For example, you could create a
separate content module for each course unit or section.

The online course objectives that you set out in the course-planning phase will help to
determine how you’ll use Content Module in your course. If you’re creating a truly web-
based course, material that would be presented in the classroom in a traditional course
would be offered online through the content modules. In this case, the content modules
would probably make up the bulk of your WebCT CE course. However, if you’re using
WebCT CE to supplement a classroom course, the content modules may play a less
significant role.

LEARNING OBJECTIVES

After completing this lesson, you’ll be able to:
e create a link to Content Module on your Course Menu and Homepage.
e modify Homepage links.
e upload a zip file of course content and unzip it.
e add course content files to a content module.
e create a table of contents that organizes the course content in a meaningful way.

¢ add tools to content pages that students ca